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You’re InvIted
Don’t miss the opportunity for your entire team to learn valuable tools and best
practices from dozens of Dentrix and industry experts.
The Dentrix Business of Dentistry Conference is the must
attend event for dental professionals. In three, informative
days, you’ll gain the knowledge and resources you need to
maximize your Dentrix investment, improve productivity,
boost profitability and enhance patient care.
The most relevant industry topics will be featured including:
• The latest Dentrix technology
• Effective practice management strategies
• Emerging clinical treatments
• Social media marketing and more
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busIness and In lIfe
This year’s Business of Dentistry Conference will feature an
inspirational keynote address by Mark Sanborn, the president
of Sanborn & Associates, Inc., an idea studio dedicated to
developing leaders in business and in life. Mark has authored
seven books, including You Don’t Need a Title to be a Leader
and The Fred Factor: How Passion in Your Work and Life Can Turn
the Ordinary into the Extraordinary. You’ll be both challenged
and inspired as you listen to Mark’s optimistic message and
valuable insights for extraordinary living.

Visit www.BusinessOfDentistry.com to read speaker
bios and course descriptions, watch videos, and
register for the most informative and entertaining
gathering of dental professionals you’ll attend all
year. Space is limited.
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New Products and Columns
From the Editor
In this issue of Dentrix Magazine, we’re pleased to introduce new
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products that improve practice management and new columns that
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provide practical Dentrix tips you can put to use right away.
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The cover story, “Announcing Dentrix G5,” introduces the most
recent version of Dentrix. From the new SQL database to the new API
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and the improved insurance claims management capabilities, Dentrix
G5 is designed to improve stability, efficiency, and integration. Read
this article and visit www.dentrix.com/g5 to learn about the benefits
and new features available in the latest version of Dentrix.
If you’ve ever thought, “I wish Dentrix did this or that,” the new
Dentrix Tips & Tricks column is just for you. Read this column to learn
valuable but easily overlooked Dentrix features that simplify workflow
and increase efficiency. And, because IT is integral to effective
practice management, we’ve added TechNotes, an occasional
column for dental IT consumers that simplifies business technology
and computer issues. The column will be authored by members of
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the Henry Schein TechCentral team, a group of experts who have
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Electronic Services

been installing and supporting computer systems in dental practices

Corey Krebs Director of Customer Service

for over 15 years.

Howard Bangerter Product Manager
Adam McDaniel Product Manager

We’re also pleased to introduce Dayna Johnson—an office manager,

Tammy McHood Product Manager

a certified Dentrix trainer, and the founder and principal consultant
of Rae Dental Management. Her new column, The Dentrix Office
Manager, offers targeted advice for office managers. Dayna’s passion
for efficient and profitable management is grounded in over 18 years
of personal experience and professional expertise.
Thank you for reading Dentrix Magazine. To download digital copies

Dentrix Magazine is published four times a year for
the benefit of Dentrix customers. Copyright ©2012 by
Henry Schein Inc. All rights reserved. Dentrix, Henry
Schein and the ‘S’ logo are registered trademarks of
Henry Schein, Inc. All other trademarks are property
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for your entire team, please visit www.dentrix.com/magazine.

To contact Dentrix Magazine, send correspondence
to Dentrix Magazine, 727 East Utah Valley Drive,
American Fork, UT 84003; call (801) 763-9300; or send
email to dentrixmagazine@henryschein.com.

Regards,

Although published material is intended to be
accurate and free from error, typographic or
otherwise, Henry Schein will not assume liability for
loss or damage as a result of reliance on this material.

Matt Singerman
Editor

contents

Dentrix Magazine Volume 24 Issue 1 — Spring 2012
www.Dentrix.com/Magazine

D e pa rt m e n t s

02	Reading Guide
04 Dentrix News
06	Tips & Tricks

10

22 patient care

Saving Time With Multi-Codes
Multi-codes make scheduling, charting, and treatment planning faster
and easier.

24	The Dentrix Office Manager
Write Offs and Fee Schedules

Learn the difference between write-off adjustments and fee schedules
and the advantages and disadvantages of each.

26 Business of Dentistry
The Forgotten Patients

If you want to see how well your practice is doing, take a look at your
patient retention and you will get an accurate account.

C ove r St o ry: A nnounc i ng
Dentr i x G5

Learn how the new database architecture
and other new features, such as eEOBs
and the Screen Capture feature, will
improve your practice.

16

28	TechNotes

10 Security Safeguards You Can’t Risk Ignoring
These 10 tips will help you safeguard your practice information.

30 Dentrix by the Numbers

Launc h Dentr i x Labwo rk In to the
Clou d wi th Henry S chein DDX

With Henry Schein DDX, it’s easier
than ever to send electronic lab
case prescriptions and get accurate
information about case status and
expected return date.

Dentrix Magazine | 1

Reading Guide
If You Manage
Appointments

Billing & A/R

Clinical Records

Insurance

Management Reports
Marketing
Office Computer Systems
Patient Information
Recall

Read These Articles
New Features in eCentral 3.0, page 4
Dentrix Mobile Now More Powerful on Popular Tablets, page 5
Dentrix Tips & Tricks, page 6
The Forgotten Patients, page 26
Announcing Dentrix G5, page 10
Write Offs and Fee Schedules: Which Should I Use?, page 24

Dentrix Tips & Tricks, page 6
Launch Dentrix Labwork into the Cloud, page 16
Saving Time with Multi-Codes, page 22

HIPAA 5010 Software Update, page 4
Dentrix Tips & Tricks, page 6
Announcing Dentrix G5, page 10
Write Offs and Fee Schedules: Which Should I Use?, page 24
Dentrix Tips & Tricks, page 6
The Forgotten Patients, page 26
10 Security Safeguards You Can’t Risk Ignoring, page 28
Dentrix Tips & Tricks, page 6
The Forgotten Patients, page 26

How To Learn More
If you want to learn more about the Dentrix topics featured in Dentrix Magazine, check out these self-paced learning resources.
Dentrix Magazine Online
You can access free PDF versions of Dentrix Magazine on
the Dentrix website. Here you’ll find the current issue of the
magazine as well as several past issues. Every member of your
team can download his or her own copy of the magazine, and
you can access the magazine when you are away from the
office. Browse to www.dentrix.com/magazine today to access
Dentrix Magazine online.

Dentrix Help Files
In the Dentrix Help Files, you can explore a comprehensive
list of conveniently indexed topics or search the topics for key
words. To search the Help files, from the Help menu in any
Dentrix Module, click Contents, click the Search tab, type a
search phrase or topic name, click List Topics, and then under
Select topic, double-click the topic name. Tip: To turn off the
search highlights, press F5.

Dentrix Resource Center
The Dentrix Resource Center offers an online library
of on-demand software training videos, downloadable
product manuals, and a knowledgebase of technical support
articles. Access is free for dental practices on a Dentrix
Customer Service Plan. Log in today at www.dentrix.com/
resource-center.

Dentrix eNewsletter
Sign up for the free Dentrix eNewsletter and receive tips
for using Dentrix, practice management advice from industry
consultants, and news about product releases and training
events. Sign up today at www.dentrix.com/newsletter. To read
previous articles, visit www.dentrix.com/articles.
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Get Dentrix News, Tips
and Information
The Dentrix eNewsletter will help you stay up to date
on the latest Dentrix product information, education
opportunities, industry news, tips and tricks,
promotional offers and more!
Once a month you’ll receive an eNewsletter
featuring the following content:

ProDucT informaTion
Training anD suPPorT
ParTner ProDucTs
TiPs anD Tricks
The DenTal Business

Sign up today at
www.dentrix.com/newSletter
and don’t miss out on the most up-to-date Dentrix information!

www.Facebook.com/Dentrix
www.Twitter.com/Dentrix
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Dentrix News
HIPAA 5010 Software Update

HIPAA 5010 is a revised set of HIPAA standards that governs
electronic transmission of administrative healthcare transactions. The standards affect the way electronic transactions, such
as claim submission, remittance advice, claim status inquiries,
and eligibility inquiries, are formatted and transmitted.
While many of the changes will be unnoticeable, some may
require an adjustment to your current practices. Below are a few
changes that you should be aware of so you can make changes
now or plan accordingly.
1. Every provider address must use a nine-digit ZIP code
(ZIP+4).
2. For electronic claims, the Billing Provider name and Pay-To
Provider address (that appears in the Primary Dental

Insurance window) will be sent in the claim and is where
payors will send payment. The Rendering Provider name
and Billing Provider address will also be sent in the claim
and reflect who performed the services and the location
where services were performed.
3.	The Billing Provider address can no longer be a P.O. Box; it
must be the physical address of the provider where services
were rendered. However, the Pay-To Provider address can
either be a P.O. Box or physical address. The Pay-To Provider
address should reflect where payors need to send payments
(which may be different from the provider’s address where
services were rendered).
4. Legacy IDs (such as Medicaid IDs, BCBS IDs and so forth)
may no longer be sent in electronic claim submissions.
Correct NPI numbers are required. Your front-office staff will
need to contact insurance payors to verify that they have the
correct NPI numbers in their provider tables.
Your practice must be fully compliant by March 31, 2012.
Failure to make these changes could result in rejected claims
or misdirected claim payments. For more information about
Dentrix and HIPAA 5010, visit www.dentrix.com/5010. For help
implementing these changes, contact eServices Support at
800-734-5561.

eCentral 3.0 is Loaded with New Features

The latest release of eCentral breaks new ground by
allowing patients to confirm appointments from printed postcards. Patients simply scan a quick response code (QR code)
to open a window containing appointment details and clickable options. One of the options is to confirm the appointment, which updates Dentrix automatically. Other options
allow patients to update their personal calendars, view a map
and directions to your office, or click to phone the practice.
Appointment emails have also been updated to improve
their effectiveness. In fulfillment of a highly-requested
enhancement, the Confirmation and Contact Provider
buttons were added to the top of the email so they are easier
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for patients to see. Plus, a new button was added to the email
reminder that allows patients to add the appointment to a
personal calendar.
eCentral email reminders also now contain links that
allow patients to get directions to your office or view account
balances. By clicking the View Balance button, patients will
see a visually improved login screen where they can view
outstanding account balances, make an online payment or
perform other functions while logged into their accounts.
Lastly, eCentral now displays a pop-up on the desktop
to relay text message replies. When patients reply to a text
message appointment reminder with anything other than the
confirmation response that updates Dentrix, the message
will be proactively displayed on your desktop so the patient’s
message does not go undelivered.
For additional information or setup instructions, click
What’s new in eCentral 3.0 in the eCentral Help or call
800-734-5561.

Dentrix Mobile Now More Powerful on iPad ® and Xoom™

Dentrix Mobile has an enhanced user interface for the
®
iPad and Xoom™ that includes a new appearance and added
functionality. The new layout and color scheme make better use
of the larger viewable area so information on patient demographics, appointments, prescription history, and medical alerts
is easier to view.
Additionally, the appointment schedule display now matches
the colors selected in the Dentrix Appointment Book for each

provider, which gives users improved recognition and consistency. The display can be changed to view by operatory or
provider. Plus, operatories and providers can be toggled on and
off to improve usability.
This latest update also allows Dentrix Mobile users on an
iPad or Xoom to add notes in the Appointment Book remotely.
Notes can be added for a specific patient or for a specific day.
For example, if while confirming an appointment a patient
inquires about tooth whitening, a note can be added to the
appointment to discuss the treatment further. Or, if while out
of the office an office manager remembers that supplies need
to be ordered the following day, a note can be created. In both
cases the notes are automatically updated in Dentrix, eliminating the need to remember the information for later entry.
Customers with Dentrix eCentral have even more functionality with this update. Patient appointments can now be
confirmed on an iPad or Xoom. The confirmation is automatically
updated in Dentrix so confirmation calls can be made outside
of the office or after normal business hours. The program also
allows users to update the patient eligibility status and initiate
an automatic eligibility verification.
For more information about Dentrix Mobile and the new
functionality for tablet devices, please visit www.dentrix.com/
mobile or call 1-800-DENTRIX.

Dentrix Wins Dentaltown Townie Choice Awards ®
Dentrix was again ranked #1 in the annual Dentaltown
Townie Choice Awards for 2011. Dentrix received awards for
Best Practice Management System and Best Periodontal
Charting.
The Townie Choice Awards were started by Dr. Farran
and Farran Media, publisher of Dentaltown Magazine, to
assist dentists in making product purchasing decisions and
are considered the “people’s choice” among the products
and services available in the dental industry today. Since
Dentaltown first started the Townie Choice Awards in 2003,
Dentrix has won best practice management software every
year and earned a total of 20 awards.
Dentrix is honored to be recognized for the ninth consecutive year as the best practice management system by one of
the dental industry’s most respected dental publications.
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easily overlooked Dentrix features that simplify
workflow and increase efficiency. Find the
tips that correspond to your responsibilities
in the practice and try them out today. Start
making your job easier and your practice

Tired of typing the same clinical note information
over and over again? Set up custom clinical note
templates to prompt you to add important information such as dates, type and amount of anesthetic
used, and type of materials used to ensure your
notes are detailed and accurate. For more information about Clinical Note Templates, see the Clinical
Notes Management webinar recording in the
Dentrix Resource Center.
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more profitable.

Use Clinical Note Templates for
Information You Commonly Use
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The tips in this section describe valuable but

Move an Entire Day’s Appointments
If a provider calls in sick or an operatory needs to close for emergency repairs, you can move
an entire day’s appointments and reschedule multiple appointments at once with the Move
to Pinboard feature in the Appointment Book (Dentrix G4 Productivity Pack 7 or higher). You
can move a selected appointment, family appointments, provider appointments or operatory
appointments to the Pinboard. For more information about using the Pinboard, see article
#47551 in the Dentrix Resource Center knowledgebase.
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Use Daily Huddle to Monitor Daily, Weekly,
and Monthly Goals
Are you using the Daily Huddle Report (available with
G4 Productivity Pack 8 or higher) to review the events
of the previous day and make plans for the current
day? The Daily Huddle Report lists daily practice
statistics about production, collections, case acceptance, new patients and scheduling which can help
your team monitor progress on monthly goals and
improve your business operations and patient care.
For more information about using the Daily Huddle
Report, browse to www.dentrix.com/articles, click the
Product Information link, and open the Introducing
the Dentrix Daily Huddle article published on 12/21/10.

Create Custom Remarks Templates for
Insurance Claims
Insurance billing experts say that short explanations
of why treatment was performed can make all the
difference when carriers are considering whether or
not to cover procedures. You can create templates
for frequently used remarks which can be added
to claims in the Office Manager > Maintenance >
Practice Setup > Custom Notes > Claim Remarks
Setup. Then when creating a claim, double-click
the Remarks for Unusual Services block and click
Claim Remarks. To learn more, see the Customizing
Insurance Claims Remarks topic in the Dentrix Help.
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Do you want to update your treatment plan
fees that have passed their expiration dates,
but still honor those that have not? With
the Update Treatment Plan Fees button
in the Treatment Planner, you can specify a
cut-off date for the update and all treatment plan procedures posted before that
date are updated according to the patient’s
current fee schedule. For more information,
see article #15566 in the Dentrix Resource
Center knowledgebase.

s
rd
co
Re
al

Keep Treatment Plan Fees
Current
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Edit Family Relationships without Closing

It doesn’t happen often, but at times you may need to edit family relationships in Dentrix due
to situations such as marriage or divorce. You can edit family relationships from the Edit menu
in the Family File, including setting or changing the Head of House, moving patients between
two families, adding patients to a new family, or merging families together. And now there
is no need to close Dentrix on all office computers before making these changes! For more
information about editing families, see the Family Editing webinar recording in the Dentrix
Resource Center.
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F2 = Select Patient

Here’s a Dentrix keyboard shortcut you
may not be aware of. In any patientspecific module, you can open the
Select Patient dialog box by pressing
F2 on the keyboard.

Tips
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We can help you

attract
new patients
to keep your
practice healthy

NEW PATIENTS

• Determine new patient goal
• Manage online reputation and reviews
• Implement a patient referral program

Christy Conway
Henry Schein Sales Consultant
“I start by assisting dentists in
setting their new patient goal and
then reviewing strategies to meet
that goal. This includes managing
their online reputation and patient
reviews, and coordinating all
online activities such as the
practice's Web site,
Facebook page, and
YouTube videos. Helping
my dentists make a few
relatively small changes
has resulted in
generating an
additional 10 – 20
new patients
a month!”

To discuss NEW PATIENTS
or other business-enhancing solutions:
Contact your local Henry Schein Sales Consultant
or call 1-800-372-4346 (PROMPT 6)
Visit www.HenryScheinWeDoThat.com
CODING HR MARKETING NEW PATIENTS OSHA OVERHEAD REDUCTION
PERIODONTAL MANAGEMENT
PRACTICE ANALYSIS
RECARE
SOCIAL MEDIA
TEAM HARMONY
TRANSITION PLANNING
WELLNESS

www.HenryScheinWeDoThat.com
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Jay Wood
Product Marketing Manager

Announcing

Learn how the new database architecture and
other new features, such as eEOBs and the Screen
Capture feature, will improve your practice.
Henry Schein is pleased to announce the release of Dentrix G5—the most
recent version of our award-winning practice management software. With this
release we are laying the foundation for a profoundly improved user experience
with new possibilities.
New Database Architecture
For the first time, Dentrix will store information in an SQL database, which
delivers several distinct benefits to our users. Most importantly, it has significantly
improved the speed of data access and overall performance of the application.
This is because individual computers no longer manage their own access to the
Dentrix database on the server. Instead, the SQL database will handle requests
from computers and centrally manage database access.
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Figure 1. With Dentrix G5 you can accept electronic Explanation of Benefits directly into the Ledger.

this new data architecture also
improves product stability. during
our entire seven-month beta testing
process involving over 100 customers, not
a single tester reported having to rebuild
their database. As dr. Walls of Walls
Family dentistry reported, “New features
are nice, but performance improvements
deliver real benefits, keeping me and my
team productive.” his advice to dentrix
customers is “don’t leave this on the
shelf.”
With a new database, customers will
naturally want to know if they will have to
buy a server or if they can run dentrix G5
in a peer-to-peer configuration. As with
previous releases, we recommend using a
dedicated server. But we have tested and
will continue to support dentrix running
on a computer that is also configured to
be a workstation. Customers who opt for
this configuration should pay particular
attention to the hardware recommendations, as this configuration will put a
greater processing burden on the server/
workstation computer.
the SQL database also employs a datamasking technique using crypto-graphic
technologies for improved data protection.
With medical professionals under strict
regula-tory obligations to protect their
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patients' personal health information,
dentrix G5 provides an important line of
defense for both patient and practitioner.

New Dentrix Developer Program
Unauthorized applications that
attempt to directly access the dentrix
database will be denied access, further
protecting personal health information
from malicious programs. For this reason,
henry Schein has launched a developer
program, which includes an application
programming interface (APi) to facilitate
and encourage the development of
dentrix-compatible software programs.
With the integration technology that
we are making available to developers,
they will be able to more easily create
software to read from and, in some cases,
write to the dentrix database. As developers take advantage of these capabilities, dentrix users will enjoy access to
a growing collection of authorized,
integrated applications that improve
practice efficiency and productivity.
“the new APi has been a great
benefit for our team,” reports Brian
Porter, director of integrations for
demandforce. “there is so much
information available today that it can be
overwhelming. the real value is getting

the right information to the person who
can best make use of it, when and where
they need it. The new Dentrix API will let
us do just that, collecting information
from inactive or prospective patients and
presenting it to office staff in the application they use to manage their day-to-day
work at the point of decision where it will
be most useful to them.”
The Dentrix Developer Program is
reaching out to a broad array of application providers in the dental market
to take care of our mutual customers.
“This new API is a great opportunity
to increase the level of integration
between TeleVox solutions and Dentrix
G5,” says Scott Zimmerman, president
of TeleVox Software. “Our ability to
deliver faster and stronger integrations
will make a huge impact on improving
the end-user experience.”
The API is also helping our development teams improve our own eServices
integration. For example, with Dentrix
G5, you can now accept electronic
Explanation Of Benefits forms (eEOBs)
directly into the Dentrix Ledger from
eCentral’s Insurance Manager. You will
be able to inspect remittance advice,
and when you click to accept the EOB it
will automatically record it in the Ledger,

Figure 2. Dentrix G5 includes a new screen capture utility.

reducing manual data entry and mistakes
(Figure 1).
One of the advantages of our new
integration technology is the opportunity it creates for motivated and
enterprising dentists who want to get
involved in software development. Some
dentists have expressed a desire to be
able to modify their system to work just
the way they want. Dentrix G5 empowers
these dentists with access to our API
that lets them easily integrate custom
code with Dentrix.
Some dentists have enthusiastically
embraced this new opportunity. When
he heard about it, Dr. Busch remarked,
“This is fantastic! Henry Schein has
delivered to their users what no other
dental software developer has offered. If
a feature is really important to me, I can
have it developed and integrated into the
software I’m already using. I can make my
software be exactly what I want it to be.”

Rigorous Beta Testing Process
Upgrading customers can take
comfort from knowing that Dentrix G5
has gone through a longer and more
rigorous beta testing process than any
previous versions. When we asked some
of our more than 100 beta testers what
they thought of the software, here is what
we heard:
“We’ve been Dentrix customers for a
long time. Dentrix G5 is noticeably faster
than older versions. Modules open faster

than they did before. The Select Patient
dialog box opens much faster. Not a lot
seems to have changed in the way you do
things, which suits me fine. All in all I’m
very pleased with version G5.“ (Dr. Imel,
Goodland Dental Arts – Goodland, KS)
“The upgrade was very smooth; we
didn’t have any problems. The best thing
about Dentrix G5 is how much faster it is.
It is definitely worth the time to upgrade.”
(Dr. Medici, North Belmore, NY)
“With 48 computers, Tidewater
Dental Associates is a large dental office.
As soon as we installed Dentrix G5 we
saw improvements to how well the
application performed. The installation
went very smoothly. Now our customers
can run reports much faster than they
could before, and the computer isn’t
tied up, so they can keep working while
the report is being generated.” (Tom
Blandford, president & CEO, eTrepid)
We at Henry Schein are gratified by
the overwhelmingly positive response
that we have received from our beta
testers. To those who have volunteered their offices and time, we say
“thank you.”

New Screen Capture Feature
Dentrix G5 also offers a variety
of new and enhanced features. In
particular, it improves electronic claims
management. The new Screen Capture
Feature lets users drag a box around
any portion of their screen to capture

an image. This image is then automatically saved to the Document Center. The
Screen Capture feature even lets you
capture images from third-party software
that you use for imaging. This is especially
useful for creating digital X-ray attachments for eClaims.
To use the new Screen Capture
feature, from the Acquire menu in the
Document Center, click Screen Capture
to display the Screen Capture dialog
box (Figure 2). If you want to set up the
default settings for screen captures, click
Setup Defaults to display the Setup

Figure 3. You can set default settings for
screen captures.
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Strengthened Fraud Detection
Fraud detection and prevention has also been strengthened
in Dentrix G5 with the addition of
sequentially numbered daysheets.
Any time the daysheet is previewed
or printed, a number is affixed to
it so managers and auditors will
know exactly how many times the
daysheet has been accessed. When
combined with password-protected
login credentials, they will know
exactly who has been accessing the
daysheets and when, without gaps
in the record.

Figure 4. Dentrix G5 displays a message when electronic claims are missing attachments.

Acquisition Method Defaults dialog box
(Figure 3). After setting the defaults, click
Save and Close. To capture a screen,
click Start Capture.
Position your mouse pointer where
you want to start the capture and drag to
capture the image.
When you release the mouse button,
the Document Center opens, and the
image you captured appears in it.
Improved eClaims Submission
Validation
For offices that use eClaims, Dentrix
improves submission validation. If users
attempt to submit claims to carriers that

require attachments and there is no
attachment for the claim, the system will
present an alert to warn the user of the
omission (Figure 4). With more complete
validation, fewer claims will be rejected
and delayed.
Insurance claim submission in Dentrix G5 is HIPAA
5010 compliant. The software collects and sends
the additional information
required by updated
regulations as part of the
normal workflow design.

Learn More
To learn more about Dentrix G5, visit the Dentrix G5 page at
www.dentrix.com/g5 to see installation help and new feature
training. You can also log in to the Dentrix Resource Center to find
these same G5 topics on the On-Demand tab. See “How to Learn
More” on page 2 for instructions on accessing these resources.

Receiving the Upgrade
At this point you may be
wondering, “When will my office
receive the upgrade?” We have
already begun shipping Dentrix
G5 to current customers who are on
a Dentrix Customer Service Plan,
and we expect to ship it to all of our
customers on a current customer
service plan through the coming
months. If your office is not on a
customer service plan, now is a
great time to re-enroll by calling
1-800-DENTRIX.

Get More Done in Less Time with
Automated Postcard Reminders
Dentrix Communication Manager

Odds are, you’re probably sending recall cards to
your patients when it’s time for them to schedule an
appointment. With Communication Manager, you
can have them sent automatically for about the same
price – freeing up your time to focus on other tasks.

Communication Manager will:

Postcard Reminders are
now interactive!

• Reduce open chair time

Patients using a mobile
device can scan a QR code
to confirm appointments,
update their calendars or
view a map and directions.

• Eliminate costly inventory
• Improve front office efficiency

Scan here for a special offer!

To learn more call 1-800-DENTRIX or visit www.Dentrix.com/AppointmentBliss

©2012 Henry Schein, Inc. *Offer only valid for existing Dentrix Communication Manager customers that have not previously utilized automated postcard reminders in the last 12 months. Postcard
reminders must be activated by April 30, 2012 to receive free 30 day trial. Offer excludes postage. A-ESCMPC-Q212

Launch Dentrix Labwork into the
Cloud with Henry Schein DDX

Holly Holm
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Campaign Marketing Manager

T

he term “cloud computing” has been used to refer to
a variety of capabilities, like data storage, instantaneous
file sharing across multiple users and wide geographies,
and universal access to information that keeps businesses
running. It’s important to note that many cloud services have
been around for a while, including now-ubiquitous products
like iTunes™ and Gmail™. Newer companies like Dropbox ® are
distilling the power of the Internet down to amazingly simple,
low-cost offerings that speed up the basic ways we share
information. With today’s stable ISP bandwidth and operating
platforms, it’s easier than ever to work “in the cloud.”
So, while not a new concept, running a business in the cloud
is an exciting concept that has many implications for the dental
industry that are just now being realized.
For example, according to Noah Levine, senior editor at
www.dlpmagazine.com, “The advantages of universal access
and easier file sharing fit naturally into what dental labs [and
practices] do every day. Simple, direct communication with a
clinician can help labs avoid frustrations, and with the cloud in

play, collaborating with outsource partners, dentists, surgeons,
and suppliers can be accomplished in a variety of simple ways.”

The Henry Schein Cloud and DDX
Many dentists view the cloud as an elusive goal—a distant,
utopian future that some may think requires sizeable investments in software and equipment to implement. For many
doctors, distrust of security, questions about HIPAA compliance, and perceived productivity loss while staff trains will slow
adoption of cloud technologies in the short term.
Fortunately for Dentrix users, they are already using cloudready Henry Schein products and services. Services like eClaims
are long-established, but newer capabilities including Dentrix
Mobile and Henry Schein DDX extend the possibilities to every
dentist and dental lab.
In particular, Henry Schein DDX is an extremely powerful tool
dentists can use to submit new prescriptions to their labs right
from Dentrix. They can share lab case information, collaborate
on case design, and manage account details like payments and
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statements. Even better, all this detail
is integrated with digital restoration
technologies dentists use every day,
like Dental Wings and E4D. DDX makes
it possible to pull images and files from
several disparate networks that dentists
and labs use and create one single, webaccessible case—with just a few clicks by
either team.
DDX is primarily built and delivered
online with no software installation
necessary. Dentrix users can start their
first case with a DDX-enabled lab in
seconds. All they have to do is click the
DDX button in the Patient Chart and
select New DDX Lab Case Prescription,
and a lab prescription is pre-populated
with that patient’s information (Figure
1). The digital lab prescription can be
sent to any lab, anywhere, with imaging
files of any size attached, and from any
web browser. The best part? DDX is
completely, 100% free for dentists.

DDX and the Cloud
In the cloud, the lab prescription is
just the beginning. Once a dentist takes
a few seconds to submit the prescription,
the DDX-enabled lab receives an automatic alert that the case is coming (or, if
the practice chooses, the lab receives an
automatic pickup request). Practices can
even schedule the patient’s follow-up
appointment right in the chair, since DDX
instantly generates an accurate turnaround date based on the lab’s real-time
production calendar (Figure 2).
With just a few clicks, the lab case
and all its related information are in
the cloud—trackable, transparent,
with any needed files attached—and
viewable by dentist and lab anytime,
anywhere, forever.

Figure 1 Practices can create a lab prescription with just one click in the Patient Chart.
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Digital Lab Case Management
with DDX: How is it working?
There were over 35 million lab cases
in the US in 2009. Given a total caseload
of 20-50 cases per month per dentist
and hundreds or thousands of cases
per month per lab, DDX brings a critical
aspect of the patient experience under
better supervision. DDX provides an
atmosphere of easy case collaboration
for both dentist and lab, while significantly reducing phone calls, lost staff
time, and costly rebookings that slow
patient flow for dentists and production

Efficiency

67% of DDX-enabled practices say

DDX makes their practice more efficient.
Competitive edge

58% of practices increased the volume of
cases they submit to their DDX-enabled lab.

Profitability

35% of practices credit DDX for reducing
patient rescheduling.

managing their current
job responsibilities,
improving production
and customer service,
or even to making
outbound marketing
efforts to generate
new business.
According to
Bruce Lieberthal,
Henry Schein vice
president of emerging
technologies, “This
revolution has resulted
in true increases in
efficiency, security,
accessibility, immediacy, and simplicity.
Figure 2 Prescription information like return date and
Running software in
status is automatically updated online and viewable by
the cloud frees the
the practice and the lab.
user from concerns
about the complexities
of obtaining, installing,
for labs. Since many dentists work with
and maintaining software and hardware
multiple labs, and most labs work with
and, allows them to focus instead on
many dentists, these teams can now log
exploiting anywhere, anytime access to
in and view a centralized case record,
one’s programs and data—and the time
with no lost reporting time to patients,
savings that immediately result.”
lab managers, or doctors.
With DDX’s responsive, flexible
In the short time DDX has been
customization platform, practices and
available, DDX-enabled practices say
labs can agree on the criteria required
that DDX helps them improve their
for a case and then standardize that
efficiency, competitive edge, and
criteria so no incomplete prescription
profitability. In March 2011, a survey of
can ever be submitted. This partnership
DDX-enabled practices found that 67
has led to a better service for both dental
percent of practices saw around a 30
practices and labs.
percent reduction in phone time for their
In the words of Susan Huff, general
staff after implementing DDX. That’s time
manager of DentalOne Partners, a large
those employees can now dedicate to
dental practice management service

provider, “We partner with
DDX on the enhancement of
the lab slip, the graphics, and
the reporting enterprise and have
been able to share ideas. Henry
Schein has supported our training
of the product and has taken on
lab enrollment.”

Put DDX and the Cloud to
Work for You Today
For practices wanting to move toward
totally paperless practice management,
using DDX is a small step that harnesses
the power of cloud computing and
delivers necessary changes fast, inexpensively, and with measurable results.
DDX provides dentists and labs with
a universal network to communicate
using technologies they already have,
which will help practices prepare for
other changes in the future as they move
toward paperless practice management.
It’s important to realize that, as with
any new service, labs and dentists will
need to work together to implement
digital processes that enhance, not
impede, their current workflow. If your
lab doesn’t yet use DDX, it’s very easy
to get them on board. Simply send
their info to the DDX team at
www.DDXDental.com/Suggest_a_Lab,
and the DDX team will follow up. Or, you
can search for and send cases to labs in
your area that are already DDX-enabled
at www.DDXDental.com/Find_a_Lab.
To get started today or to suggest that
your lab become DDX-enabled, visit
www.DDXDental.com/Dentists.
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Stay in touch with
Your Practice.
Anytime, Anywhere.
Dentrix Mobile
On-the-go access from the leader
in practice management software
Dentrix Mobile makes sure you’re never more than
a touch or a tap away from the crucial information
that powers your practice—with fast, secure
access to patient details, appointments, medical
alerts, and prescriptions from any BlackBerry®,
iPhone™, Palm Pre™, or Android™ smartphone or
from your iPad™ or Motorola Xoom™ tablet. And,
Dentrix Mobile is included with the latest version
of Dentrix.*

Get Dentrix Mobile and stay
in touch with your practice.

To learn more call 1.800.Dentrix or visit www.Dentrix.com/Mobile

©2012 Henry Schein Inc. Other products are trademarks or registered trademarks of their respective owners. *Dentrix Mobile is free with a Dentrix Customer Service Plan. A-DTXMOB-Q212
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learn how.
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Make a Plan to Go PaPerless
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streamline workflow, reduce waste
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to become a paperless office. Practice
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Center, the Office Journal, patient
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forms, and more!
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efficiency

Master the basics

Learn to increase production through
effective use of Dentrix clinical
tools. Discover how to improve case
presentation and increase case
acceptance, create multiple treatment
cases, use the Treatment Planner
to manage treatment options, use
customized clinical notes to make
charting fast and efficient, and learn
tips for efficient perio charting.

Gain a broad overview of the basics.
Learn step-by-step how Dentrix makes
daily routines easier and more efficient.
Designed to help newer users with
some previous experience to master
the basics of the Appointment Book,
Family File, Office Journal, Treatment
Planner, Ledger, Continuing Care,
Insurance Manager, Office Manager
and more!

6

person
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1-day class for experienced
Dentrix users, 9am – 5pm
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Patient Care
Saving Time With Multi-Codes
Multi-codes make scheduling, charting, and treatment planning faster and easier.

Gary Frazier | Contributing Editor

D

id you know that Dentrix multicodes can help you maximize your
efficiency as you schedule, chart,
plan, and post treatment?
Some treatments, even common ones
such as an adult’s periodic exam, consist
of several procedures. Multi-codes save
you time by letting you group up to eight
procedure codes in a single multi-code.
So, rather than entering all the procedure
codes for a periodic exam separately, you
can enter the codes simultaneously using
a single multi-code. For your convenience,
Dentrix includes several pre-defined

multi-codes, but you can easily edit these
multi-codes or create your own.
To create a multi-code, from the
Maintenance menu in the Office
Manager, point to Practice Setup, and
then click Multi-Code Setup. Click New
in the Multi-Code Setup dialog box
(Figure 1). From the Multi-Code Editor
dialog box, type a description of the
multi-code that you are creating, the
code number you want to use for your
custom multi-code, and an abbreviated
description. Next, select an appointment
type and a procedure type. Dentrix

Simplify the task of scheduling, charting,
billing, and treatment planning using multicodes—you may be surprised at how much
time you’ll save.
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inserts a procedure time automatically as
you add procedure codes. Click Add and
type or select the procedure codes that
you want to include in your multi-code.
Depending on the procedure codes
that you select, Dentrix requires you to
specify the surface, quadrant, and/or
sextant. If the procedure requires a tooth
number or range, you can supply this
information when you post the procedure
in the Patient Chart or the Ledger.
Once you’ve set up a multi-code,
you can use it just as you would a procedure code.

Scheduling
You can speed up your scheduling
using multi-codes. In the Appointment
Book, for example, if you were scheduling
an adult patient’s periodic exam that
included a prophy, four bitewings, and an
evaluation, you could post three procedure codes or just use the one predefined
multi-code for an adult prophy. To use this
multi-code when scheduling an appointment, from the Appointment Information
dialog box, click Misc. Under Category,
select Multi-Codes. Select xxCCA and
click OK.
Tip: You may want to edit the CCA
multi-code in the Office Manager to
include D1204 Fluoride – Adult and
D1330 Oral Hygiene Instructions. For a
procedure requiring additional information, such as a tooth number or range,
you must specify this information in the
Patient Chart or the Ledger and then
treatment plan the procedure before
scheduling the appointment; otherwise,
you cannot set the procedure complete.
Charting
After creating a multi-code, you could
create a procedure button in the Patient
Chart and assign the multi-code to it.
To do this, from the Setup menu, click
Procedure Buttons Setup. Click New.
Under Procedure, expand Multi-Codes

Figure 1. The Multi-Code Setup dialog box.
and select the multi-code that you want
to use, such as xxCCA. Under Select
Button Face, select Use Image or Use
Code Text and then select an image or
a font, respectively. Click OK , and then
click Close. Now charting a patient’s
treatment is as simple as a mouse
click, and since there is no limit to the
number of procedure buttons you can
create, with a little time and thought,
you can create any number of multicodes and assign them to procedure
buttons to make your charting fast,
efficient, and consistent. Once you click
the Completed button in the Patient
Chart, Dentrix automatically posts the
completed work to the Ledger, and
you’re ready to bill.

Treatment Planning
Treatment planning is easier using
multi-codes too, especially since you
can “bundle” several multi-codes to
create other even more comprehensive
multi-codes.
For example, since some treatments,
such as partials or orthodontia, require
several follow-up visits over an extended
period, you can create and use bundled
multi-codes to create treatment plans for
them. To treatment plan monthly

Figure 2. The Multi-Code Editor dialog box.

orthodontia visits, first, create a
periodic ortho exam multi-code named
xx801 using PerOrtho as the abbreviated description. Add the D8670

retainers. Once the full case multi-code
is complete, you can use it to treatment
plan two years of orthodontia with a
single code.

Multi-codes save you time by letting
you group up to eight procedure codes
in a single multi-code.
Periodic Orthodontic Treatment procedure code eight times to this multi-code
(Figure 2). Set up two more multi-codes
following the same pattern as the first,
but naming these multi-codes xx802
and xx803 and using PerOrtho2 and
PerOrtho3 for the abbreviated descriptions, respectively.
Next, set up a fourth multi-code for
the full case and name it xx800. Add the
xx801, xx802, and xx803 multi-codes to
the full case multi-code. The full case
orthodontia multi-code now contains
24 monthly visits to which you can add
up to five other procedures, such as
records appointments and

Multi-codes are very versatile and
allow you to get as creative as you like.
Because the Dentrix modules are so
highly integrated, you can use multicodes wherever procedure codes are
used in Dentrix. Simplify the task of
scheduling, charting, billing, and treatment planning using multi-codes—you
may be surprised at how much time
you’ll save.

Learn More
To learn more about creating multi-codes,
see the Multi-code Setup topic in the Dentrix
Help. See “How to Learn More” on page 2 for
instructions on accessing these resources.
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The Dentrix Office Manager
Write Offs and Fee Schedules
Learn the difference between write-off adjustments and fee schedules and the
advantages and disadvantages of each.

Dayna Johnson | Dentrix Certified Trainer

I

n my home state of Washington,
a large dental insurance company
slashed our filed fees by 15 percent
last year. Several offices I work with have
called me asking for advice on how to
deal with it now that even the non-PPO
plans are working under a much lower
fee schedule. This article explains two
approaches you can take when faced
with this scenario. You can either apply
adjustments (write-offs) or update your
fee schedules in Dentrix. Both methods
work well, but there are pros and cons to
each, so you should choose carefully.

Using Adjustments (Write-offs)
Offices using the write-off system bill
out the full fee for the procedure and
then perform an adjustment (write-off)
in the Total Insurance Payment dialog
box of Dentrix Ledger to account for
the difference between the office fee
and what the contracted fee is with the
insurance company. On their billing
statements, patients see the full fee and
also an adjustment showing how much
money their dentist is losing by being
a member of their PPO dental plan.
Also, in the write-off system, the dental

much of an increase should be made to
the fee schedule.
I love this method! However, there is
a disadvantage that you should consider.
The Dentrix Treatment Planner is not
able to account for that difference when
you present the treatment plan. Your
office team will be required to make
hand-written adjustments to the treatment plan estimate, which may not look
professional. Also, it may be challenging
to collect on the day of service since the
Ledger cannot accurately calculate the
patient’s portion if the full fee is being
posted to the Ledger. Even though this
method requires some tricky work on the
calculator, some offices still prefer to use
this method.

Using Fee Schedules
Offices that work with multiple PPO
plans should use fee schedules. With this
method, the office team must keep the fee
schedules current, update the coverage
table accurately, and attach the fee
schedule to the insurance plan properly.
When I discuss this method with
team members, the most frequent
comment I get is, “I want to bill my full

Using fee schedules when you are contracted with an
insurance company will give you more accurate accounting
of production, help your front office team collect more
accurately on the day of service, and help give your patients
an accurate treatment estimate when accepting treatment.

insurance companies are automatically
billed the office’s higher fee, rather than
the PPO fee, which can help when the
insurance company later looks at how
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fee to the insurance company, and that
is why I have never switched to using fee
schedules.” The good news is, with fee
schedules, you can still bill full fees to the

Figure 1 You copy a fee schedule using
the Automatic Fee Schedule Changes
dialog box.
insurance company. All you have to do is
change the claim format to the DX2007F
when you are attaching the fee schedule
to the insurance plan. I’ll show you how
to do this in a moment.
There are three significant advantages
of using fee schedules: (1) Collecting at
time of service is accurate on the Ledger;
(2) The treatment plan estimates are accurate, so you don’t have to do any manual
calculating;(3) The production for the day
will reflect the PPO adjusted production
amount on your daysheet. These are huge
advantages for your team!
Let’s walk through it together so
that you can start seeing those benefits
sooner rather than later. After obtaining
a copy of your fee schedule from the
insurance company, in the Dentrix Office

Figure 2 Update the fee schedule in the
Automatic Fee Schedule Change Results
dialog box.
Manager, from the Maintenance menu,
point to Practice Setup, and then click
Auto Fee Schedule Changes to display
the Automatic Fee Schedule Changes
dialog box (Figure 1). Next to Select
Fee Schedule, use the selection button
to select the fee schedule you want
to update.
In the Automatic Fee Schedule
Changes dialog box, under Select
Operation, select Copy Fee Schedule
To, then click the selection button and
select the same fee schedule (you will
copy it to itself). Click Copy.
In the Automatic Fee Schedule
Change Results dialog box (Figure 2),
find the first procedure code in the list
where you need to make a fee schedule
change, double-click the value under
New Fee, change the amount, and
click the green checkmark. Make other
fee changes as needed. When you’ve
finished, click Accept to update your
fee schedule.
Now that your fee schedule is set
up, you can attach it to the dental
insurance plan using the Family File. To
do this, after selecting a patient in the
Family File, double-click the Primary
Dental Insurance block. On the Dental
Insurance tab, click Insurance Data to

display the Primary Dental
Insurance Plan Information
dialog box (Figure 3). Next
to Fee Schedule, click the
selection button and select
the appropriate fee schedule
for the plan (the fee schedule
you just updated). Next to
Last Update, you should
also enter the current date
so you have a record of the
latest changes.
While you’re in this
dialog box, if you want to bill
your full fee to the insurance
company, set the Claim
Format to DX2007F. The F
tells the Dentrix software
to bill the fee schedule fee
amount to the patient’s
Ledger and the full fee to
the insurance company.
When you use the
DX2007F claim format,
remember that you will be
billing out full fees to the
insurance companies. When
you receive your EOB from
the insurance company,
Figure 3 Attach the fee schedule to
it may look like you need
an insurance plan in the Primary Dental
to do an adjustment because the
Insurance Plan Information dialog box.
submitted amount will be greater than
the allowed amount; but remember,
the patient’s Ledger already has the
will give you more accurate accounting
correct PPO fees, so no adjustment should
of production, help your front office
be necessary.
team collect more accurately on the day
The final step in the setup is making
of service, and help give your patients
an accurate treatment estimate when
sure the Coverage Table is accurate.
accepting treatment. This is a win-win for
When using fee schedules, do not use
the Payment Table unless there is a
everyone!
specific procedure code that falls outside
the fee schedule coverage percentage.
Learn More
(A good example of this exception
To learn more about adjustments, see the
Adjusting Insurance Payments Automatically
would be the downgrade for posterior
topic in the Dentrix Help. See “How to Learn
composites.) Using the Payment Table
More” on page 2 for instructions on accessing
does cause the estimate calculations to
these resources.
be different.
If you are just switching over to using
Dayna Johnson, founder and principal
fee schedules and your patient has an
consultant of Rae Dental Management, helps
existing treatment plan, you will need
dental offices improve patient care, increase
to use the Update Fees feature in the
collections, and reduce staff headaches by
Treatment Planner in order for the treatimplementing efficient management systems.
ment plan estimate to reflect the new fee
With 18 years experience in the business
structure. Once you’ve used the Update
and technical side of dental offices, Dayna’s
Fees feature, you can print the patient
passion for efficient systems is grounded in
estimate just as you did before, but now
both personal understanding and profesit will reflect an accurate estimate without
sional expertise. Dayna can be reached at
any manual calculations.
dayna@raedentalmanagement.com or visit her
Using fee schedules when you are
website at www.raedentalmanagement.com.
contracted with an insurance company
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Business of Dentistry
The Forgotten Patients
If you want to see how well your practice is doing, take a look at your patient retention and
you will get an accurate account.

Sandy Pardue | Director of Consulting, Classic Practice Resources Inc.

I

don’t know of one practice that has
patients lined up outside the front door
waiting to come in to get dentistry. Our
public is not as excited about dentistry
as we may want to believe. Practices are
focusing on getting patients in the front
door with little attention on the best
patients: the ones that have benefited
from their services in the past.
Patients are falling through the cracks
in the majority of practices. Patient retention is averaging 55% or less. If you want
to see how well your practice is doing,
take a look at your patient retention and
you will get an accurate account. Are
more patients leaving through the back
door than coming in through the front?
When I ask dentists how they would
like to improve their practice, a common
response is, “I need more patients.” They
are usually concerned about patient flow,
but they skip key practice management
protocols to keep patients coming back.
These forgotten patients know you, they
know your team, they know where you
are located, and they consider YOU their
dentist. It is not unusual to find another
practice hidden in a single practice. I am
referring to patients in need of a recall
appointment or other treatment that has
been diagnosed.
Every practice must know that
retaining patients is vital to practice
expansion and viability. Every person
on the team must know that the existing
patients are the most important part of
the practice. Work on adding value to
visits and building stronger relationships
with your current patients. My experience
has been that the longer the patient stays
away, the less likely it is that they will
return to your practice. Many are already
embarrassed about their mouth. The
more time goes by, the more embarrassed they become about putting it off,
so they go somewhere else.
There are 3 common ways patients
can fall through the cracks.
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Figure 1. You can use the Continuing Care module to get a list of patients
who are overdue for their routine cleanings and exams.

1) Lack of a solid Recall and
Reactivation System— Most practices
believe they have a recall system that is
working. It is rare that I find this to be the
case. You need to have a written plan
that states who is responsible for what
and has an exact schedule for cards and
emails to be sent. This is so that staff
members can follow the system exactly,
month after month. Employees come
and go; you need to have the system
established so it can be easily duplicated
by the next person.
Even if you are utilizing Dentrix
services like automatic appointment
reminders with the Communication
Manager, you should be aware of the
timelines and templates you have set
up so you can follow up with patients.
Practices that have these systems in place
continue to grow despite the economy.
2) Staff not familiar with dental
software —Every team member must be
trained on the software. The knowledge
they gain will greatly benefit the practice.
This is an area where you cannot afford

to cut corners. Your software allows
you to do many things to help prevent
patients from falling through the cracks.
For example, you can use the Continuing
Care module to find patients who are
overdue for recall appointments or the
Treatment Manager to track patients
with outstanding treatment plans. You
and your team need to know how to take
advantage of these resources you already
have within Dentrix.
3) Little or no communication from
the practice —It is important that you
communicate with your patients using
recall cards, recall emails, reactivation
projects, birthday cards, holiday cards,
etc. Some type of communication is
better than none at all. The more you send
out, the more appointments you will get.
Dental teams are constantly looking
to fill their schedules and improve new
patient numbers. These actions are
important, but the one thing that seems
to be missing is a solid recall and reactivation program to close the back door and
retain more patients. When these patients

stay with your practice and are happy, they
will refer more people like them.
Most practices are not doing enough
on a consistent basis to keep patients
coming back. Often times, patients are
inactivated too soon. This is a huge
mistake. They still have teeth and they
still need a dentist. They are either going
to see you or go somewhere else. Six
months goes by fast, and people get
busy with life. Don’t write them off. Use
automatic continuing care due reminders
in the Communication Manager to keep
the communication flowing to them.
One of the most important things you
can do to build a practice is to put your
attention on your current patient base.
I recommend that you do a reactivation
project similar to the one below every year.

Learn How Many Patients in
Your Practice are Overdue
The average practice has 750 to 1000
patients overdue for their recall appointments. This is largely due to weak or
lacking recall and reactivation systems.
Patients get left behind because no one
goes back and works the Continuing Care
list and the practice stops sending cards
and letters. Most practices are surprised
to learn how many people need to come
in, especially when they have open time
on their schedule most every day.
To learn how many overdue patients
you have in your practice, you can
generate a list in the Continuing Care
module. You want to find out how many
patients haven’t been in for six months
or longer, going back three to five years.
Open the Appointment Book and click
File > Continuing Care. Select View >
All so that all patients who are overdue
for recall appear on the list. From
there you can set up a temporary view
to narrow your search. Click Views >
Temporary View. In the Last Visit Date
Span group box, change the dates from
5 years to 6 months and click OK . You will
be surprised at what you find (Figure 1).
Note: In order for patients to appear
on the Continuing Care list, you must be
attaching continuing care to patients in
the Family File. If you are not attaching
continuing care to patients, you can
run the Inactive Patient list in the Office
Manager to find patients with a last visit
date that was at least six months ago.
Reactivation Project
Typically, a practice will start thinking
about doing a reactivation project when
they are desperate for patients. The
reactivation attempts should be ongoing

for a consistent flow of patients rather
than a desperate move.
Step 1: Generate and print a list of
patients that have not been in for at least
six months and go back at least 3 to 5
years (See the steps above to generate
the list).
Step 2: Choose a recall card to be
mailed to them. You may also consider
combining this with emails to the
patients. The recall cards and emails
should look different than what you have
been sending in the past.
Step 3: Customize your recall email
message. Our surveys show the following
message gets the best response.
Dear [insert patient name],
We miss seeing you in our office. As
you know, when dental decay, gingivitis,
periodontal disease or other complications are discovered in early stages,
treatment is not complicated and costs
are less. Please phone the office at [insert
your phone number including area code]
for a convenient appointment.
Step 4: Send the same card and/
or email message to the same group of
patients two to three months in a row.
Work to implement a patient retention system to help close the back door
and keep more patients. Focusing on
patient retention will not only fill your
schedule, it will provide a steady flow
of patients, and you’ll have a much
healthier practice.

Learn More
To learn more about generating the
Continuing Care list, see the Continuing
Care List View Options topic in the Dentrix
Help or visit the Dentrix Resource Center to
view the Managing Your Continuing Care
System webinar recording. See “How to
Learn More” on page 2 for instructions on
accessing these resources.
Sandy Pardue is an internationally recognized lecturer, author and practice management consultant. She has assisted hundreds
of doctors with practice expansion and staff
development over the past 25 years. She is
known for her comprehensive and interesting
approach to dental office systems, and offers
a refreshing point of view on how to become
more efficient and productive in a dental
practice. Sandy is Director of Consulting with
Classic Practice Resources and was named
a “Leader in Consulting” by Dentistry Today
magazine for the past 10 years. She is also a
consultant to leading dental companies for
product evaluation and design.

Are You
Prepared for
HIPAA 5010
Compliance?
Dentrix Has
You Covered.
In fact, Dentrix customers are already
submitting HIPAA-compliant claims.
Understanding all the requirements
can be daunting. That’s why Dentrix
offers extensive online resources for
everything HIPAA 5010 — including
software update information, payor
news, preparation articles and more.

800-734-5561
Contact us to learn more
about sending HIPAA 5010
compliant claims.

www.Dentrix.com/5010
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TechNotes
10 Security Safeguards You Can’t Risk Ignoring
These 10 tips will help you safeguard your practice information.

Jason Werner | Marketing Manager, Henry Schein TechCentral

Y

ou probably lock your practice’s
front door at night. I bet you lock
the back door, windows, and
employee entrance as well. But locking
doors and windows alone doesn’t
protect your practice entirely from intrusion or threats. If you have an Internet
connection, you need to safeguard
that entrance into your practice as well.
In today’s ultra-connected world with
Internet access on everything from PCs
to phones, you must take computer
security precautions seriously so you
don’t leave your practice at risk.
Protecting your practice requires you to
make network and data security a priority,
especially now that more of your records,
business transactions, and data are
digitized and accessible over the Internet.
Here are ten things you can do to
reduce your risk and better protect your

Figure 1 Enable password security in
the Practice Passwords Setup dialog box.
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practice. Much has been
written on computer security,
and this list is certainly not
a complete list of all the
security safeguards available to you. However, if you
follow these simple tips, your
practice information will be
much safer than if you don’t.

1. Require passwords.
I’m amazed at the number
of offices I come across that
don’t require passwords for
their Dentrix systems. You
should require a password on
every computer, all the time.
Don’t let users share their
passwords. Don’t write them
down on a little yellow slip of
paper and tape them to your
computers for all to see.
To set up passwords
in Dentrix, from the
Maintenance menu in
the Office Manager, point
Figure 2 Specify user security rights in the
to Practice Setup >
Password Administration – User Passwords Setup
Passwords, and then click
dialog box.
Practice Passwords Setup.
In the Practice Passwords
Setup dialog box (Figure
Manager Open (farther down the list)
1), select Enable Passwords. Once you
and click OK.
enable passwords, Dentrix protects
Use the Password Administration
all the tasks appearing in the Security
– User Passwords Setup dialog box
(Figure 2) to specify a password adminisOptions list. In order for users to
perform any of these tasks, you must
trator. You can then use this same dialog
assign them rights to the security
box to set up user security rights for
the password administrator. Repeat this
option. (Note: Do not click OK until you
follow all the instructions in the next
procedure to set up user security rights
two paragraphs).
for all your Dentrix users.
First, however, you need to assign a
2. Use strong passwords that
password administrator. Select Require
Secure User Passwords to require
can’t be guessed. Your name is a bad
passwords to be at least seven characpassword. As a rule, mix numbers, words,
ters long and to contain alphanumeric
symbols and capitalization in your passand special characters. Then, from the
words. A good example is “Gr8D3nti5t!”
Security Options list, select Password
(think “Great Dentist!”). However, you
can’t use that one now that I’ve told the
Administration (at the top) and Office

whole world. (See Rule #1 above.) Create
a variation of an easy-to-remember word
or words, like your first car, pet’s name, or
favorite hobby. Many Internet sites today
already require passwords containing
a mix of characters, and this is a good
practice for you to follow with passwords
in your office as well.
Can’t remember all your passwords?
Neither can I. Get a reputable password
manager for your smartphone. They keep
all your passwords close at hand, security
encrypted, and you can back them up
somewhere safe in case you lose your
device. It is worth the $.99 to $5.99 investment. And yes, you’ll need a password
for your password manager as well.

3. Keep your software up to date.
Operating systems and programs, especially browsers, must be patched continually to protect against new threats. Keep
all your software, especially the software
you rely on most, up to date. This goes
for your Dentrix software as well.
4. Protect yourself from viruses.
Running antivirus software on every
computer is a must, and each computer
must have regular updates to its antivirus
software. Check your antivirus software
periodically to determine when the last
time your protection was updated and
when the last full scan was completed. If
it’s been a while for either one, turn on
your software’s automatic update feature
and adjust the automatic scan schedule.
5. Never use an unsecured wireless
network. We all love free Internet access
while we wait for coffee, our dinner, an
oil change, or our dental appointment.
And yes, your patients will love you for
it too. However, leaving your Wi-Fi open
for all to use puts you at risk. You’ll want
to configure your wireless router so it
doesn’t openly broadcast your Wi-Fi
network for all to see. You will also need
to provide patients with the exact Wi-Fi
network name and password you’ve
chosen. That, however, is a small price to
pay to keep lurkers in the parking lot from
stealing access to your wireless network
and slowing your Internet access speed.
6. Separate your Wi-Fi networks.
If your practice is thinking of deploying
wireless networking for your patients and
your business use, the best option is to
set up one Wi-Fi for your patients’ use
and a separate, isolated, and secured

Wi-Fi network for your business data.
Don’t mix them, or you could open the
door to unauthorized access of your
business systems. You can configure most
quality wireless routers to create two
networks to keep business and patient
wireless traffic completely separated.

7. Use an Internet firewall. A
properly configured firewall helps you
protect the sensitive information your
patients have entrusted you with. It acts
as a barrier to your practice’s network,
letting the good traffic in and keeping
your network out of reach from Internet
hackers. Don’t have a firewall? Get
one ASAP.
8. Filter your Internet content. Most
firewalls provide some level of Internet
content filtering. That puts you in control
of what your patients and staff
can access while on the Net.
X-rated photos and videos
are not the sort of things you
want your network used for.
There have been cases where
unsecured networks have been
used to access illegal content,
and the networks’ owners were
blamed. Internet filtering will
also block malware (malicious
software that invades your
network and creates problems)
and questionable websites
that are known to contain
dangerous software. Internet
filtering, just like antivirus
software, is continually updated
to protect your network from
ever-evolving threats.
9. Scrutinize incoming
email. Email also exposes your
practice to risk. Be suspicious of
email messages from any senders you
don’t recognize, and only open emails
from sources you trust. Don’t open
emails, click on links, or open attachments from sources you’re not comfortable with. One simple click can open
your PC and network up to malware
attacks.
10. Remove all data from old
computers and hard drives. Are you
ready to donate that old PC or sell it on
eBay? Are you sure you aren’t handing
a stranger your patients’ sensitive data,
credit card information, and your financials? It’s amazing what can be recovered

from a hard drive because (newsflash!)
deleting a file does not make the data
vanish completely. With a little knowhow, files and data can be recovered from
discarded or repurposed drives. Use a
reputable disposal and recycling service
that will electronically, or physically, shred
your hard drives.

In Conclusion
The 10 tips discussed in this article will
provide your practice with a good defense
against the common security threats to
your practice data. To learn more about
implementing any of these solutions
contact Henry Schein TechCentral (877)
483-0382) or other qualified integration
specialists who offer help with installation
and ongoing service and support. Henry
Schein TechCentral has been providing
and supporting secure computer systems

Follow these simple tips, and
your practice information will be
much safer than if you don’t.

and networks for dentists nationwide
for more than 15 years. TechCentral
also offers secure computer equipment
recycling and environmentally friendly
disposal to keep our customers safe
and green. You can learn more about
TechCentral by visiting their website at
www.henryscheintechcentral.com.

Learn More

To learn more about using passwords in
Dentrix, see the password setup topic in the
Dentrix Help. You can also visit the Dentrix
Resource Center and view the Passwords and
the Audit Trail Report webinar recording. See
“How to Learn More” on page 2 for instructions on accessing these resources.
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Den t r i x b y t he Nu m be r s
The Most Popular Postcards of 2011
Dentrix Communication Manager automatically sends personalized postcards to remind your patients about
their next appointments or the need for a recall visit. Of the 150 postcard designs available, practices using 
Dentrix Communication Manager sent these postcards most often in 2011. Which postcards do you send?

Get Started Today
Are you ready to get started? Learn how to send postcard appointment reminders with Dentrix Communication
Manager. Download the getting started guide today at www.dentrix.com/getting-started/postcard.

Henry Schein. Office Technology
Experts You Can Count On.
So you can focuS on managing your practice.

Henry Schein TechCentral
Proven Solutions for:
• Computers
• NetworkiNg
• wi-Fi
• Audio/Video
• pHoNe sYstems
• i.t. support

managing your practice is demanding enough without the worry of computer and network problems. You
need a trusted technology partner to keep your practice’s systems productive and secure. Henry schein
experts are ready to help with business solutions for budgets of all sizes. Ask how Henry schein techCentral
solutions can power your digital practice with a reliable network, computers and expert support.
available exclusively from

Call 877.483.0382 or visit www.henryscheintechcentral.com
©2012 Henry schein inc. A-dtXmtC-Q212

DENTAL

Henry Schein Practice Solutions
727 E. Utah Valley Dr.
American Fork, Utah 84003

WARNING!
Do not hire this guy. It’s a lot quicker
and painless with Dentrix.

Who is The Dental Enforcer?
He’s nobody you want to know — trust us. Hiring him could be
a damaging and costly mistake for your practice. Vigilante
dental justice is not the answer!
Patient late on a bill or missing appointments?
You may be desperate, but avoid him at all costs.
He’s armed. He’s dangerous. He’s a thug in a lab coat.

For more information, videos and tips for
avoiding an encounter with The Dental Enforcer visit

www.Dentrix.com/Enforcer

©2012 Henry Schein, Inc. A-ESENF-Q212

